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Geomagic® Control X™ is a comprehensive metrology software platform that delivers the industry’s most powerful tools within 

straightforward workflows. With Geomagic Control X quality managers are enabled with revolutionary ease-of-use, intuitive, 

comprehensive controls and traceable, repeatable workflows for the quality measurement process. Its fast, precise, information-rich 

reporting and analysis enable significant productivity and quality gains in any manufacturing workflow.

Ensure Quality Everywhere
Bring the power of 3D scan-based inspection to more people in more places with industry-leading 3D metrology software that makes 
it easy to capture and interpret scan data.

What Can You Do with Geomagic Control X?
Geomagic Control X includes features to help you ensure quality for each stage of your manufacturing workflow including designing, 

manufacturing, inspecting, and maintaining.

Design
•	 Design for 

manufacturability

•	 Find and fix problems

Manufacture
•	 Identify and resolve 

manufacturing and 

assembly issues

•	 Eliminate costly scrap and 

rework

Inspect
•	 Solve your toughest 

measurement problems

•	 Improve quality 

documentation

•	 Reduce quality control 

bottlenecks

Maintain
•	 Assess damage, 

deformation, or 

wear accurately and 

consistently

•	 Predict part failure before 

it happens

1	 INTRODUCTION

INTRODUCING GEOMAGIC® CONTROL X™ 
Version 2022.1.0
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2	 INSTALLATION

System Requirements
For the latest system requirements information and to learn about specific qualified system configurations, go to the System 

Requirements page in the Geomagic Support Center. Some users have had success running system configurations that deviate from 

the supported listed on our website. In such cases, these configurations are not officially supported by 3D Systems, Inc.

Additionally, we test a variety of hardware platforms in combination with the graphics subsystems. While we make every attempt to 

be as thorough as possible, hardware manufacturers change their products frequently and may be shipping newer products or have 

discontinued active support for others. Check the support section of the website for the latest system requirement information and 

specific qualified systems.

Download and Install software
You can download and install the software from https://support.3dsystems.com/s/article/Geomagic-Control-X.

In addition, automatic software updates are available if you set the Update Product Automatically option to True in Preferences and 

a valid maintenance code is activated, and your computer is connected to the Internet. The application will check if a newer version is 

available and will download it automatically for installation.

You can also manually check if a newer version is available by going to Help > Check For Update.

Activate License

Geomagic Control X requires license activation to run the application on your PC. You can choose to use an evaluation license for a 

15-day period or activate a permanent license by using an Online Activation license or a physical dongle. 

After you start your application, the License Manager window opens. The License Manager allows you to activate and use the 

Geomagic Control X software.

NOTE: When you launch the License Manager, you can click the Help  button found at the top right corner of the window to 
read the CimLM Licensing Guide. 
For more information, go to the Licensing section on the getting-started page.

Geomagic Control X Viewer is available with a valid Geomagic Control X license. If you are a trial user, you can run Geomagic 

Control X Viewer as long as the trial license is maintained on your PC.

Note: Auto-update is unavailable for Geomagic Control X Viewer.

Notice

https://support.3dsystems.com/s/article/Geomagic-Control-X
https://support.3dsystems.com/s/article/Geomagic-Control-X
https://support.3dsystems.com/s/article/Geomagic-Control-X
https://support.3dsystems.com/s/article/CimLM-Licensing-Support
https://support.3dsystems.com/s/article/Geomagic-Control-X
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Improvements to Visual Scripting Tool
The following improvements were made to support flexible and easy utilization of the Visual Script.

New Actions

The following actions have been newly added and improved to 

increase the utilization of the Visual Script.

General Operations

Geomagic Control X 2022.1.0 Geomagic Control X 2022.0.1

Note - Enables you to add notes to the script.

Select Files - Enables you to select files, folders,  

and subfolders, upon which to perform one or 

more actions.

Setup Parameters - The Leading Parameters 

action has now been changed to “Setup 
Parameters.” This action allows you to define 

global parameters that can be used in the scripts.

The Setup Parameters dialog can now be 

configured to include images, icons, separators, 

and headers, change the properties of 

parameters, and more.

What’s New in 2022.1.0
Geomagic Control X 2022.1.0 includes improvements to automation workflow using Visual Script and Automation Server, and feature 

selection using geometries. This release also includes bug fixes reported since Geomagic Control X v2022.0.1.

Note: The  /  labels indicate features that are also available in Geomagic Control X Essentials and Geomagic Control X 
Essentials Connect software packages.

3	 NEW FEATURES AND ENHANCEMENTS
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Delete Poly-Faces/Vertices - The new “Delete 
Poly-Faces/Vertices” action has been added to 

the Measured, allowing you to delete poly-faces 

or poly-vertices from selections.
Report - The new “Custom Fields” action has been 

added, allowing you to import external custom 

fields list file that defines summary information of 

a project, and match the custom values to each 

field to include them in the report.
Select - Contains the selection tools that allow you 

to select entities by defined criteria.

The following actions are available in the Select 

operations:

•	 Custom Selection

•	 Inverse

•	 Select All

Geomagic Control X Operations

Geomagic Control X 2022.1.0 Geomagic Control X 2022.0.1

Word-Wrap for A Long Line of Text

Word wrapping is now used automatically when typing a long line of text or resizing the action dialog.

Geomagic Control X 2022.1.0 Geomagic Control X 2022.0.1
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Colored Pre-Defined Expression

Pre-defined expressions are highlighted when it is used in the Expression action so that they can be distinguished from other user-

defined expressions.

Zoom-In by Drawing a Box

The Script Editor Canvas can now be zoomed in by drawing a box.

A New Wait Until End option in Run External Command Action

A new “Wait Until End” option has been added to the Run External Command action, allowing you to let the Visual Scripting process 

wait until the Run External Command action ends.
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Updating sockets in real-time while typing expressions

Input or output sockets are updated in real-time while typing expressions, and the values are applied without pressing the Enter key.

A New Foreachiter Expression

A new “Foreachiter” expression has been added. This expression sets the number of iterations to count from 1 if it is used inside the 

ForEach action. However, if it is used outside the ForEach action, the number of iterations is set to 0.

Browse Button for File Search

The Browse button has now been added to the Setup Parameters dialog to facilitate file search and file path setup. 

Note: The Setup Parameters dialog can be configured by clicking Customize Parameters on the contextual menu of the Setup 
Parameters.
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Contextual Help for Visual Script

The contextual Help is now available for Visual Script. You can get help when using the Visual Script Editor by pressing F1 or clicking 

Help on the context menu.

Improved User Interface of Actions

Improved readability by rebalancing socket icon size and strings in the User Interface of actions.

Geomagic Control X 2022.1.0 Geomagic Control X 2022.0.1

Adding Description to Script

The Geomagic Control X Visual Script Editor now allows adding a description to a script so that you can better represent the script 

when sharing it with others. To add a description to a script, open the Visual Script Editor and go to File > Properties.

New Properties in the File menu Adding a description to a script
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Improvements to Geomagic Control X Automation
The following improvements were made to enhance the stability of Geomagic Control X Automation and the ability to check 

immediate automatic inspection results.

Re-run Geomagic Control X after Inspection X Times

A new “Re-run CX after inspection x times” option has been added to the Geomagic Control X Automation (Client). This option 

allows you to re-run the application continuously at every scheduled inspection process with the Geometric Control X Automation 

even in the event of any errors or crashes.

Pass/Fail Results in Geomagic Control X Automation (Server)

Inspection results such as ‘OK’ or ‘No Go (NG)’ per inspection part can now be checked in the Inspection Result window immediately 

during the automatic inspection process in the Geomagic Control X Automation.

Monitoring results of inspection items  

in Geomagic Control X Automation Server

OK - If all inspection 

results are passed.

No Go (NG) - If any of 

inspection results are 

failed. 
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New Selection Method
A new selection method has been introduced that allows you to select poly-faces or poly-vertices on the desired area by user-defined 

geometries and reuse them for other corresponding scan data in an automated inspection workflow using scripts.

Select by Geometry

A new “Select By Geometry” tool has been introduced. This tool allows you to select poly-faces or poly-vertices on the desired area 

by using a box or cylinder.

Selection by Box Selection by Cylinder

Reusable Custom Selections

Selections defined by a box or cylinder can be added 

as Custom Selections to the Result Data and reused for 

other corresponding scan data.

The pre-defined Custom Selections can be used in a combination of multiple Selection (Custom Selection) actions for an automated 

inspection workflow using scripts.
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Miscellaneous Enhancements
•	 Display Issues in Visual Script - Improved readability by mitigating blurred display issues during zooming in/out in the Visual 

Script.

•	 Stability of Visual Script - The stability of Visual Script has highly been improved. In particular, intermittent issues have been 

improved in which folders and variables entered in expressions are not recognized.

•	 Select Poly-vertices from Point Cloud - The Vertices selection type of the Select Poly-Faces/Vertices tool in the Scan Process 

Designer is now available for point cloud.

Licensing & Installer
The following improvements were made to the Licensing System and the Installer:

•	 The language that was set in the previous version is retained when the user auto-updates to the newer version.

•	 The licensing system has been more robust to prevent activation errors and lost licenses in some cases.

•	 The Auto-Update capability is now prevented from being installed by passing command-line arguments, “Setup.exe  

/noupdate” during installation.
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What’s New in 2022.0.1
Geomagic Control X 2022.0.1 includes improvements to automations using Visual Script, and scan post-processing using Hexagon 

Structured Light Scanner Interface. This release also includes bug fixes reported since Geomagic Control X v2022.0.0.

Note: The  /  labels indicate features that are also available in Geomagic Control X Essentials and Geomagic Control X 
Essentials Connect software packages.

CHALLENGE:
The following capability was required to support flexible 

inspection automation processes and expand the usage 

of the Visual Script.

•	 A new way to run a saved script file without manually 

opening Geomagic Control X and the Visual Editor

•	 A new action that enables to reset the path for 

searching input data files

•	 A new action that contains multiple input data in a 

single array and enables to use it as a single set

SOLUTION:
New command-line argument
A new command-line argument is now available to support command line interface for Visual Script. You can simply enter arguments 

in the Command Prompt and directly run inspection workflows designed in the script file.

New Set Working Folder Action
A new Utility action named “Set Working Folder” 

has been added, allowing you to change the 

default working folder to a desired folder that will 

be used as the starting point of file search. The Set 

Working Folder action can be used multiple times if 

you need to redirect the path for searching files. 

Both absolute path and relative path are 

supported.

New Data Type Actions
A new Data Type action consisting of four sub-commands such as “Data Type Array”, “Point 3D”, “PRS Pair”, and “Vector 3D” has 

been added. This allows you to contain multiple Data Type objects in a single data array and use it for various purposes.

Data Type Array Point 3D RPS Pair Vector 3D

Additional Functions in Visual Scripting Tool
Manage input data effectively and expand application of Visual Script for more automated inspection workflows.
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Improvements to Hexagon Structured Light Scanner Interface
CHALLENGE:
The following is demanded to improve stability of scan data processing in the Hexagon Structured Light Scanner Interface and 

expand the usage of the scanner interface.

•	 A new alignment method for scan groups

•	 Effective scan data management

•	 Stable scanning and scan post-processing

•	 Expansion of the usage of Hexagon Structured Light Scanner Interface for the users of Control X Essentials Connect.

SOLUTION:
Align Groups
The new “Align Groups” method is now available 

to support for the N-Point alignment between scan 

groups. This is available when a new scan is added 

to the second group.

Deletion for Unwanted Meshes
You can now delete unwanted scans at any time 

while scanning with the Hexagon Structured Light 

Scanner Interface.

Improved Stability of Scanner Interface
Stability of the scanner interface has also been improved in the following processes:

•	 Merging scans

•	 Aligning scans using a reference CAD file

•	 Multi-exposure control

Hexagon Structured Light Scanner Interface for 
Control X Essentials Connect
The Hexagon Structured Light Scanner Interface is 

now available for Control X Essentials Connect.
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What’s New in 2022.0.0
Geomagic Control X 2022 offers powerful inspection tools including Visual Scripting tool, new Hexagon Structured Light Scanner 

interface, and many enhancements to current features that provide increased productivity and traceability in your metrology 

workflows. This release also includes many more enhancements and bug fixes.

Note: The  /  labels indicate features that are also available in Geomagic Control X Essentials and Geomagic Control X 
Essentials Connect software packages.

CHALLENGE:
Preserve and automate learned expertise 

and knowhow of repeatable workflows to 

make the process more accessible to novice 

users, and reduce time and costs of repetitive 

inspection workflows. Simplify the process of 

preparing and inspecting parts.

SOLUTION:
A new Visual Scripting tool enables automation and customization of any inspection workflow in Geomagic Control X. This is based 

on a non-programming interface for the simple definition and implementation of scripts.

Scripting and workflow automation are key in standardizing work processes, which can streamline compliance and validation 

procedures. Cost savings come from automating repetitive tasks as well as from preventing user errors and operations that deviate 

from best practices.

Automation and Scripting
Enabling automation and customization of inspection workflows

The successful inspection of parts requires expertise, experience, and precision. The knowhow gathered through diligent 

experimentation and innovation can now be incorporated into automated inspection workflows. Scripting is a tool that enables 

automation of workflows, simplification of the preparation process, and standardization to meet compliance and validation 

processes.

File Import
Native CAD File Import has been updated to support the following versions.

CAD Application File Extension Version Supported Comments
CATIA V5 .catpart, .catproduct R8 - V5-6 R2021 Geometry and PMI
CATIA V6 .catpart, .catproduct Up to V6 R2021x Geometry and PMI
Creo (Pro/E) .prt, .prt.*, .asm, .asm.* Pro/E 16 – Creo 7.0 Geometry and PMI
Inventor .ipt, .iam V6 - 2022 Geometry Only

SIEMENS NX .prt 11 – NX1953 Geometry and PMI

SOLIDWORKS .sldpt, sldasm 98-2021 Geometry and PMI (2014-2021)
STEP .stp, .step AP203, AP214, AP242 Geometry Only1)

1) STEP AP242 PMI is limitedly supported and available as a ‘Preview’ feature found under the Add-Ins menu.
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Performance Enhancements
Improve productivity and efficiency with new meshing algorithm

Geomagic Control X contains numerous performance enhancements for importing files and handling meshes.

CHALLENGE:
Increase productivity and improve calculation performance.

SOLUTION:
You can save ~50% of operation time and increase productivity with new meshing and rendering algorithm that are implemented in 

the new version of Geomagic Control X.

The performance of the following commands has been highly enhanced:

•	 Merge

•	 Triangulate 

•	 Fix Normal

•	 Split

•	 Defeature

•	 Fill Holes

•	 Transform Measured Data

•	 Align Between Measured Data

•	 Combine

•	 Volume Offset

•	 Import

•	 Mesh Select

CHALLENGE:
Enable to use the Hexagon Structured Light 

Scanners within Geomagic Control X.

SOLUTION:
A new Plug-In for Hexagon Structured Light Scanners has newly been implemented. You can now connect Hexagon Structured Light 

Scanner Interface and directly scan objects in Geomagic Control X without using the Optocat application.

New Hexagon Structured Light Scanner Interface
Scanning with Hexagon Structured Light Scanners within Geomagic Control X

Geomagic Control X offers the Scanner Direct Control that enables the use of various scanning devices directly within the application. 

Hexagon Structured Light Scanners are now available in Geomagic Control X.
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New Smart Selection Tool
Selecting interesting regions on a mesh effectively

Allows to select interesting regions on a mesh based on curvature and angle.

CHALLENGE:
Improve the efficiency of region selection.

SOLUTION:
A new Smart Selection tool that selects contiguous regions on a mesh effectively based on curvature and angle, similar to the Extend 
to Similar selection tool. This allows you to dynamically control the sensitivity of selection.

Click Click + Drag Up Click + Drag Down

CHALLENGE:
Allow the user to control the position of the 

Tolerance Zone so that it can shift to be larger 

on one side of a target measurement face or 

to be only permitted in one direction.

SOLUTION:
The Surface Profile command now supports the Unequal Tolerance Zone as specified in the ASME Y14.5 - 2009 Standard. The 

new Unequal Tolerance option allows you to specify tolerance values that makes the tolerance zone distributed from the target 

measurement face unequally. This also allows you to shift the Tolerance Zone so that variation can only be permitted in one direction.

Once the Unequal Tolerance is specified, the Unequally Disposed Profile Modifier (U) is 

illustrated in the first set of the Feature Control Frame. The tolerance value preceding the (U) in 

the Feature Control Frame represents the total Surface Profile tolerance, and the value following 

the (U) represents the portion of the tolerance zone which lies on the in-space side of the target 

measurement surface.

New Unequal Tolerance in Surface Profile
Enabling unequal tolerance zone for Surface Profile

The Tolerance Zone is an allowable zone surrounding the ideal surface of a target measurement face. Depending on various 

measurement purposes, not only is this distributed from the target measurement face in both directions equally but it can also be 

shifted to allow variation to be larger on one side of a target measurement face unequally. 
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New Separate Mesh
You can now separate a single mesh object composed of multiple clusters easily.

A single Mesh Individual Meshes

Improvement of CAD Tessellated Mesh Segmentation
A new Region Segmentation algorithm has been implemented, improving the quality of region segmentation for a mesh tessellated 

from CAD. You can also easily control segmentation results by using the Slide bar.

Geomagic Control X 2020.1.1 Geomagic Control X 2022.0.0

Importing Mesh as Reference Data
You can now directly import meshes as Reference Data by clicking Import Reference Data in the Context Menu of the Model 

Manager. 

The following mesh files are available: *.xdl *.mdl *.fcs *.gpd *.3dprint *.stl *.obj *.ply *.3ds *.wrl *.icf *.dxf *.dat *.ans *.iv
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Deleting Poly-Faces or Poly-Vertices without Running Delete 
Poly-Faces/Vertices Command
You can now delete selected poly-faces or poly-vertices by pressing the Delete key without running the Delete Poly-Faces/Vertices 

command.

Updated Licensing System
The CimLM Licensing System has now been updated to the latest version of CimLM 3.2. CimLM 3.2 contains compliance related fixes 

that allow the user to enable trial licenses for Geomagic Control X.
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4	 FIXED BUGS

Bug Fixes in 2022.1.0
This section lists issues that have been resolved since Geomagic Control X v2022.0.1:

Note: The  /  labels indicate features that are also available in Geomagic Control X Essentials and Geomagic Control X 
Essentials Connect software packages.

Common  

•	 GV-22076:
When starting the application after the AutoUpdate was completed, the following message appeared.

“Server Script, Line 588: Argument 1 must be of type string.”

•	 GV-22406:

The following commands didn’t work for poly-vertices in point clouds.

•	 Box Selection Mode

•	 Cylinder Selection Mode

•	 Sphere Selection Mode

•	 GV-21675:

The following issues were found when using the Customize Ribbon command.

•	 Commands that did not exist in the current Ribbon menu were in the list of the Customize Ribbon Menu and 

they were not removed from the list.

•	 When adding a command to the custom Ribbon menu, the list collapsed and the command could not be 

added to the list.

•	 GV-21885: When turning the Sound options off in the Preferences, it continued to work in non-English locales.

Visual Script
•	 GV-21095, 

GV-21000:
The contextual Help didn’t work for the Visual Script Editor.

•	 GV-22237, 
GV-20516, 
GV-20051, 
GV-19288:

The input and output sockets were not set based on the entered expressions.

•	 GV-22554:
Failed to export a report if the target file path contained invalid characters. A notification message is now 

popped up if a file path contains any of the following characters: \/:*?”<>|

•	 GV-22568:
The Select (Select All) action worked only for visible entities. The Select (Select All) action should work for poly-

faces/vertices regardless of the visibility status.

•	 GV-22564:
A value entered in the action was used even though input value was delivered from the other actions and it 

caused different results. The parameter value in an action should be used only when nothing is connected to the 

input socket of the action.

•	 GV-21362:
Adding multiple Search actions to the Result (Add To Result) actions triggered a dialog box that interrupts 

automation.

•	 GV-21227
The Visual Script Editor would crash when clicking the “Select File” button in the File (Save Document) while a 

relative file path was defined in the parameter input box.

•	 GV-20438: Data folder was not found even though the path was set correctly.

•	 GV-22206: The application would crash when running a specific visual script.

•	 GV-21933, 
GV-20037:

Intermittent UI issues where actions were not connected by dragging or deleted by the Delete key.

File I/O  
•	 GV-22267, 

GV-5969:
The application would crash when opening projects saved in the older version of Geomagic Control X.

•	 GV-21132: Failed to import a .obj file with texture.

•	 GV-22128: The application would crash when saving the project file.



Oqton, Inc. 19

Alignment  
•	 GV-21746: Couldn’t select multiple/similar planes as a datum pair in the Datum Alignment command.

Report  
•	 GV-22317: When generating a report, an error occurred with the RFXODevice.dll issue.

•	 GV-21772
When clearing any category in the Field Chooser, a new header row with "Value" was added to the 3D GD&T 

table.

Scanner Interface 
•	 GV-22410, 

GV-21683:
When scanning with the Hexagon Structured Light Scanner, the application crashed intermittently or failed to 

obtain scan data.

•	 GV-22386: Failed to run the Hexagon Structured Light Scanner command in non-English locales.

Command Line Interface  

•	 GV-22510:
The application would crash when a report was saved during the batch processing of inspection projects with a 

configuration ini file that contains non-ASCII characters.

Automation
•	 GV-22434, 

GV-22123:
If the application was closed while it was not fully launched, rebuilding of the items in the Automation List no 

longer proceeded.

•	 GV-22247: Couldn’t start or remove the next item after removing time-out item.

•	 GV-22072:
When running more than 300 inspection items on the Automation Server/Client, the available hard disk space 

became very low.
•	 GV-16505, 

GV-21527:
When using the Share file Comm. option, the client status was displayed as "Disconnected" even if the client was 

ready.

•	 GV-22152: Items in the Inspection list were not updated based on files in the Monitoring Folder.

•	 GV-22122:
The connection between the Automation Server/Client was not synchronized while they were connected by the 

Shared File Comm.

•	 GV-22504:
When the Automation Client disconnected and reconnected while the client application was working for a 

previous inspection project, the inspection item in the Inspection List was displayed as “Crashed.”

•	 GV-22520:
The automation stopped while the Automation Client was connected to the folder in the network and the 

Automation Server was running on the network PC.

•	 GV-22418: Time-out was fixed to 1 min even if changing the time limit to 2min.

•	 GV-21697, 
GV-21625, 
GV-20614, 
GV-21325:

The application in the Automation Client crashed intermittently while automation tasks were running.



Oqton, Inc. 20

Bug Fixes in 2022.0.1
This section lists issues that have been resolved since Geomagic Control X v2022.0.0:

Note: The  /  labels indicate features that are also available in Geomagic Control X Essentials and Geomagic Control X 
Essentials Connect software packages.

Common
•	 GV-21238, 

GV-21197, 
GV-21189, 
GV-21187, 
GV-21034: 

 

There were stability issues where the application would crash during the scan data processing using the Normal 

Information Wizard, the Mesh Buildup wizard, or the Triangulate commands.

•	 GV-21018: 
 

There was a Unicode issue where GD&T groups renamed with non-English characters were replaced by a 

question mark ‘?’.
•	 GV-20986: 

 The Import and the Export buttons didn’t work in the Manage Templates in the Trend Report.

•	 GV-20745: 
 The Separate Mesh command was unavailable for a single mesh.

•	 GV-20614:
There were stability issues where the application would crash sporadically while running the Automation process 

on both the Server and the Client.
•	 GV-20733: 

 
When using Geomagic Control X with a floating license, the "In Use" Count of components was displayed in the 

License Manager incorrectly.

•	 GV-20886:
The Enter and the ESC keys on the keyboard were still working while the Scanner Direct Control command run. 

This caused the command to be closed by mistake.
•	 GV-16309: 

 Submitting an error report didn’t support Internet Explorer.

•	 GV-20922: 
 Undoing after deleting poly-faces and rebuilding the results caused the application to crash.

•	 GV-20885:
The alignment between Reference and Measured meshes would be broken when creating a custom viewpoint in 

the Result Navigator.
•	 GV-20899: 

 When selecting an aligned mesh, the highlight of the selection was shown in the wrong position on the screen.

•	 GV-20899, 
GV-20764, 
GV-20779: 

 

After any Measured Tool was canceled, unintended poly-faces were selected on both the aligned Reference 

and Measured meshes, or the highlight of the selection was shown in a wrong position on the screen until the 

viewpoint was updated by rotating or panning.

•	 GV-20773, 
GV-20756: 

 
The position of aligned measured data was not preserved after undoing deleting poly-faces or when reviewing 

mesh edits.

•	 GV-20774: 
 Extruded boundaries were previewed incorrectly in the Edit Boundaries command.

•	 GV-20794: 
 Reference data would sometimes disappear when moving the viewpoint by panning or zooming.

•	 GV-20816: 
 A target mesh would sometimes disappear when reviewing the results in the Edit Boundaries command.

•	 GV-21250: Scanning performance would be slow down when scanning an object using the Backup LSF (LiveScan File) 

option in the LiveCapture.

Hexagon Scanner Interface
•	 GV-21069: The settings in the Preferences of the Hexagon Structured Light Scanner Interface would not preserve.
•	 GV-20947: Merging would fail when using the Hexagon Structured Light Scanner Interface.
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•	 GV-21244, 
GV-20948:

There were incorrect function issues when performing the following operations:

•	 Controlling exposure values

•	 Teaching scanning process with the Turntable Automatic Calibration option

•	 Merging scans and filling holes

•	 Aligning scans using the Contour alignment
•	 GV-21068: The application became unresponsive and the screen looked expanded incorrectly when merging scans.
•	 GV-20198: The alignment using a reference CAD file didn’t work.

Faro Scanner Interface 
•	 GV-20215, 

GV-20674:
The probe function in the LiveCapture didn’t work properly for FARO Quantum S Max with probes.

Visual Script
•	 GV-21043: The Visual Script tools didn’t appear in the Ribbon Bar when using Geomagic Control X with a trial license.

•	 GV-20992:
A warning message showed up in Geomagic Control X while running a script and it caused that the script stops 

running.

•	 GV-20957: The Visual Script failed to run when a Cone type of face is input as a target in the GD&T (Line Profile).

•	 GV-20931: The local coordinate system was not assigned in the Measured (Transform Measured Data) in Visual Script.

•	 GV-21232: The shortcut keys were not available for 'Open', 'Start' and 'Stop' of Visual Script.

•	 GV-21188: Failed to create a point with the “Extreme Position” option in the Constructed Geometry (Point) in Visual Script.

File I/O  
•	 GV-17782, 

GV-20927:
The file import didn’t work properly even if the type of file is set to the same file format. This affected the 

following file formats: CyberWare Files (*.ply) and Geomagic Raw Points Files (*.pts)
•	 GV-18607, 

GV-20925:
The available import options were different for the same file format depending on what the file type filter was 

selected. 

•	 GV-20892:
When exporting scan data as an OBJ file format, the texture was excluded from the file and an unnecessary 

message was displayed.

•	 GV-20671:
The application would crash when opening a new document with the New command while unsaved data was 

loaded.
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Bug Fixes in 2022.0.0
This section lists issues that have been resolved since Geomagic Control X v2020.1.1:

Note: The  /  labels indicate features that are also available in Geomagic Control X Essentials and Geomagic Control X 
Essentials Connect software packages.

•	 GV-20416, 
GV-19398, 
GV-19725: 

 

The alignment would not be maintained when switching between results using the same scan differently for the 

Measured and Reference Data.

•	 GV-20384: After running the Move Device command, the unit of deviation results calculated from the Check and Fix 

Deviation were different from the unit set in the preferences.
•	 GV-19714: 

 The application would sometimes crash when running the Triangulate command for a certain point cloud.

•	 GV-19598, 
GV-8737, 
GV-7137, 
GV-4378:

 

Geomagic Control X didn’t support the Unequal Tolerance Zone for the Surface Profile.

•	 GV-19592:
 The Color Bar in the viewpoints disappeared when editing a 3D Compare feature.

•	 GV-19081:
 

The application would sometimes crash when entering the 2D GD&T after creating cross sections on a certain 

large mesh.
•	 GV-18572:

 
The “Sampling Ratio” option didn’t work for meshes when performing the Global And File method in the Align 

Between Scan Data command.
•	 GV-18488:

Import failed for a certain FLS file.

•	 GV-18401:
 The Normal Information Wizard command in the Scan Process didn’t work.

•	 GV-18048:
 Adding simulated CMM points on a point cloud caused the file size to grow up unexpectedly.

•	 GV-17907:
Unable to select an existing plane after going to a new position with the Move Device command.

•	 GV-17906:
The options in the Context Menu would not be selectable while scanning an object with a FARO arm.

•	 GV-17891, 
GV-16205:

 

A target mesh disappeared or moved away when completing mesh editing operations by clicking OK while the 

“Don’t Quit Command With OK” option is toggled on. This also occurred when rebuilding a project after editing 

a mesh.

•	 GV-17690:

The wrong download URL for FARO LS Software Development Kit (SDK) was displayed in the notification 

message while importing FLS files saved in a newer version of FARO Scene. The latest FARO LS SDK can be 

downloaded at : https://knowledge.faro.com/Software/FARO_SCENE/SCENE/SDK_File_Download_and_

Installation_for_SCENE
•	 GV-17491:

 
The "Precise" option in the Initial Alignment command would not maintain when editing an Initial Alignment 

feature.
•	 GV-17419, 

GV-16865:
 

A certain STL file exported from the other software caused the application to crash when importing.

•	 GV-17356, 
GV-10546:

 
Triangulation didn’t work properly for selected poly-vertices on a point cloud.

•	 GV-17235:
 

When aligning a mesh to a reference CAD by using the Coordinate Alignment command with the Moving XYZ 

and the Target XYZ options, the target mesh moved in a wrong position.
•	 GV-17203:

 A certain corrupted file caused the application to crash when opening.

•	 GV-16923:
 

The application crashed when clicking on a target model to define a position of a conical section in the Section 

command in the Curve Tools.

https://knowledge.faro.com/Software/FARO_SCENE/SCENE/SDK_File_Download_and_Installation_for_SCENE
https://knowledge.faro.com/Software/FARO_SCENE/SCENE/SDK_File_Download_and_Installation_for_SCENE
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•	 GV-16848:
 

The delta value (Δ) between two radii of circular geometries measured from Measured and Reference Data 

didn’t show up in the annotations of Geometry Deviation.

•	 GV-16622:
 

After decimating a mesh imported with Double precision, the geometry pairs would not be searched properly 

when rebuilding inspection features. This caused that the existing inspection features connected to the mesh 

become failed.
•	 GV-16523: Once PMI import failed in the PMI STEP AP242 command in the Add-ins, the application became inoperable.
•	 GV-16515, 

GV-13684:
 

Paired geometries would not be updated in the Model Manager immediately after pairing the geometries 

manually.

•	 GV-16486:
 

After undoing probing done for a first entity in the Interactive Align command, the wrong information was 

displayed in the Infocenter. 
•	 GV-16476:

 When deleting dimensions, an existing datum defined in the same feature would not be maintained.

•	 GV-16474:
 

The visibility of the Custom View that was duplicated in the other Result Data would not be maintained when 

editing.
•	 GV-16410:

 The results of Alignment would not be maintained when replacing Measured Data by using the Scan Process.

•	 GV-16406:
 The application crashed while copying and editing paired Simulated CMM points.

•	 GV-16390:
 Undoing and redoing didn’t work for imported probe sessions.

•	 GV-16319, 
GV-13412:

 
Changing annotation styles by using Preset and the Edit Annotation Style didn’t work for Simulated CMM points 

created in 2D GD&T.

•	 GV-16303:
 Defined Simulated CMM Points would not be updated when replacing with new Measured Data.

•	 GV-16149:
 The results of some measured features would not be listed in the Result Navigator when opening a CXProj file.

•	 GV-16089: The position of planes used for alignment would not be maintained while repeating actions such as undoing, 

reprobing, and redoing in LiveInspect.
•	 GV-16066:

 Unable to select poly-faces while the View Clip was toggled on and the Visible Only was toggled off.

•	 GV-16061:
 After importing a WRP file, a mesh was displayed incorrectly when rotating.

•	 GV-15949, 
GV-15948:

 
When rotating the screen during the triangulation, the application hung and became unresponsive.

•	 GV-15946:
There were several texture mapping issues in scanning with a FARO Quantum Max ScanArms.

•	 GV-15944:
 A memory leak occurred when a scanning device was in a state of rest.

•	 GV-15943:
The buttons in a FARO ScanArm didn’t work if the device was out of the Range. 

•	 GV-15915:
 While undoing poly-face deletion, hovering the mouse over the mesh caused the application to crash.

•	 GV-15856: The application sometimes crashed when pressing the A button two times quickly in the LiveAlign and 

LiveCapture.
•	 GV-15381: Some meshes were getting scaled down unexpectedly when using the batch process.
•	 GV-15302:

 The Trend Report showed values only up to 4 decimal places.

•	 GV-14893:
The application crashed when exiting the LiveCapture after scanning was done.

•	 GV-13973, 
GV-10404:

 
After opening a CXProj file or adding a new Result Data, the model view would sometimes not be updated to 

match the active Result Data.

•	 GV-13379:
 

GD&T would not be calculated for the case that Geometric Tolerancing was defined on a Constructed Geometry 

manually paired with another Measured Constructed Geometry.
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•	 GV-13105:
 

While switching between alignment methods in the Coordinate Alignment command, the manipulator would 

not be activated properly according to the selected method.
•	 GV-13072: Planes that were used for creating a point or a P.C.D circle remained even if an existing Inspection Data was 

reset in the Play LiveInspect Process.
•	 GV-10663:

 
When saving a CXProj file with multiple Result Data, some information in the inactive Result Data would be 

omitted.
•	 GV-10189:

 The Trend Report always reported the units as milliliters. 

•	 GV-8966:
 Decimating a mesh with the “Allowable Deviation” criteria didn’t make any changes in the results.

•	 GV-8174: While an overlay menu is floating in LiveCapture, pressing the OK & Exit button found at the right down corner 

of the Model View caused the application to crash.
•	 GV-8008:

The application would sometimes crash when exiting the LiveCapture.

•	 GV-7268:
 

Unable to navigate between Result Data when the number of results exceeded the available height of the 

Model Manager panel.
•	 GV-6791:

 The application crashed when editing the layout of a report. 

•	 GV-6469:
 

In the Line Profile command, the sub-options of the “Unidirectional Tolerance Zone” option would not be shown 

even if it was set to on.

•	 GV-5695, 
GV-5576, 
GV-5366, 
GV-5223:

 

There were several issues in the Report where:

•	 Some results in the report were mismatched with the results in the Tabular View.

•	 The Manage Templates window took a long to open.

•	 Failed to save a report as a PowerPoint file.

•	 Undoing and redoing didn’t work.
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